VPLAY 3

multifunctional software for 24/7 multichannel broadcast/overlay in
SD/HD formats

User Manual

2014
Content

Copyright ......................................................................................................................... 3
VPlay 3 Installation ........................................................................................................... 4
  Common settings ........................................................................................................... 7
  SNMP trap ...................................................................................................................... 8
  External Devices ........................................................................................................... 9
  Live inputs .................................................................................................................... 10
  Channels ....................................................................................................................... 13
  Key Info ....................................................................................................................... 16
VPlay Assets Manager ................................................................................................... 17
VPlay Channel Manager ............................................................................................... 24
  Empty block, Live event, GPI command and MTX control ......................................... 27
  VPlay Channel Manager interface in playback mode. ............................................... 28
VPlay Control Panel .................................................................................................... 29
VPlay Scene Editor ....................................................................................................... 30
  Attaching Logotypes and Scenes to clips in VPlay Channel Manager ..................... 35
VPlay Text Style Editor ............................................................................................... 37
VPlay Content Template Editor ................................................................................... 39
VPlay Text Content ....................................................................................................... 41
VPlay Report .................................................................................................................. 43
VPlay Monitor ............................................................................................................... 44
Internet streaming ......................................................................................................... 46
Adobe Flash Media Live Encoder 3.2 ........................................................................... 47
Microsoft Expression Encoder 4 ................................................................................... 49
XSplit Broadcaster ........................................................................................................ 50
Wowza Streaming Engine ............................................................................................. 51
Copyright

© STREAM-Labs. The content of this document must not be copied on any media without permission of STREAM Labs Inc. in writing. Copying, distribution of partially or fully protected by copyright law software VPlay, produced by STREAM-Labs, is forbidden. This rule applies to server and client software VPlay as a whole; and to separate modules and files as well.

About Company

Stream Labs Inc. was founded in 1991 and currently is one of the leading Russian companies, working on 3 major lines of products:

- TV broadcast systems.
- Video surveillance systems.
- Systems for monitoring of TV broadcast.

Stream Labs Inc. is international company with offices in USA, Europe, Taiwan and Russia (Moscow). It develops professional solutions for TV broadcast companies.

Stream Labs’ hardware and software developed for TV stations, satellite and cable TV providers gives them excellent opportunity to automate TV broadcast, control quality of broadcast via automated monitoring, implement interactive TV and advanced graphic design for TV programming.

Our company employs very creative team and our achievements in science and engineering during 15 past years have significantly enhanced the quality of our production. We deploy the most advanced technologies for design and manufacturing.

We keep developing along with our customers. We participate in all major trade shows and conferences around the world and we are perfectly aware of challenges, which our customers are facing. We have been trying to be one step ahead and meet their expectation. Partnership with our clients combined with professionalism is the key approach in our bid to success.

Our goal is to become a leading designer and manufacturer of highly professional solutions for TV industry around the globe.

Main functions

- Concurrent and independent broadcast of several channels/overlays.
- Synchronized multichannel playout.
- Simultaneous IP/web and AV (video card output) broadcast with selectable bit rate and resolution.
- Client-server architecture. Control over server is being facilitated through client freeware.
- Playback of most common video file formats cominged in one playlist.
- Maintenance of log files; support of SNMP-protocol.
1. Insert USB dongle in usb port.

In order to make VPlay Server work, it is imperative to have USB key, manufactured by Stream Labs. This USB key must always be inserted into the PC where VPlay Server is installed. In case if the key is not inserted, then the software will not function.

2. SNMP protocol configuration.

Another important step before installation of VPlay is setup of SNMP protocol on your PC. This protocol ensures communication between components of VPlay.

- Go to Control Panel -> Programs and Components -> Turn Windows features on or off

- Mark with flag component SNMP-protocol and WMI SNMP Provider; then press OK

- Then go to Control Panel -> Administration -> Services. In this window we are interested in 2 services: SNMP service and SNMP trap. Right click on each service and select Automatic Start from the «Properties»
Reboot PC.

*Note: all computers, on which you plan to install VPlay (regardless whether it is going to be server or client), must undergo this procedure.*

3. **VPlay3 installation.**

   Launch **VPlaySetup.exe**, then select folder for installation and follow the installation wizard instructions.

4. **Creating VPlay3 database.**

   At the end of the installation **VPlayDBCreator** window will appear. **VPlayDBCreator** is a utility for creating a database in SQL Server for VPlay. If you incidentally missed this step, you can find **VPlayDBCreator.exe** is in C:\Program Files\VSoft\Vplay folder.
In «VPlay Data Base Creator» window:

- Click ▼ icon to select SQL Express server name.
- Press the button «Check Database connection» to check connection to SQL server.
- Press the button «Create VPlay database and tables» to generate a database in SQL for VPlay.

5. VPlay Server Settings.

   Now we are ready to start configuring VPlay. Launch «VPlay Configurator»:
Common settings

In this window you need to connect to your database and specify server logs and configuration folder.

- **VPlay server info** – here you can assign server name, server location and server description (optional fields)
- **SQL Database connection** – here you need to select your SQL Server name, authentication and check Database connection
- **VPlay server logs folder** – here you specify the path to a folder which will contain server log files
- **Configuration folder** - here you specify the path to a folder which will contain server configuration files
In this window you add IP addresses of PC’s with client modules, server will intercept signals from clients via SNMP service. If you install client modules on the same PC with server module, then you need to add local IP address 127.0.0.1
In this window you can add to configuration external devices compatible with VPlay, for instance GPI Plugin or Kramer MTX (P2000 control).
Live inputs

In this window you can add video capture devices. These capture devices can be – capture card or IP transport stream.

If you want to add capture card or IP ts as live input device press Create New button, select AV(SDI) device or Network device and press Ok button.

On image 1 you can see Steam Labs MS2 card Live input properties:

- Live input device – capture device (optional)
- Live input name – capture device name (optional)
- Live input description – capture device description (optional)
- Video format – live input video signal standard and format
- Enable analog video – True for analog, False for SDI signal
- Enable analog audio – True for analog, False for SDI signal
- Enable deinterlace video – enable or disable deinterlacing
On *image 2* you can see Network live input properties:

![Image 2](image2.png)

**Live input name** – the name of the live source

**Live input description** – the description of the live source

**Stream type** – stream type UDP or RTP/RTSP

**Url** – specify RTP/RTSP url (e.g. rtsp://server.example.org:8080/test.sdp)

**Network interface** – specify network interface

**Host** – specify multicast or unicast ip address

**Port** – port
Stream (program) – here you can choose certain program from MPTS (multiple program transport stream) *puc. 3*

**Image 3**

- **PID Stream** – stream identifier
- **PID Video** – video stream program identifier
- **PID Video Type** – video stream program identifier type
- **PID Audio** – audio stream program identifier
- **PID Audio Type** – audio stream program identifier type
- **Enable deinterlace video** – enable or disable deinterlace video
In this window you configure your channels, output sources, input sources and external devices.

Right click (image 1) and select Add Channel to create a channel. In the panel with properties (image 2) you can configure properties of your channel:

- Channel name – your channel name
- Channel log folder – your channel log folder
- Channel work folder – your channel work folder (contain clips, logos and scenes)
- Channel time zone – your channel time zone
- Video format – your channel video signal standard and format
- Audio – number of audio channels
- Empty block action – here you assign an action that will be executed if schedule encounters an empty block or there is no schedule for current day:
  - Black field – black field will play
  - Media file – you can assign media file that will play in a loop mode
  - Live – you can assign live video input for play out
- Deinterlace – enable or disable deinterlacing
- Scale – you can select scale factor LetterBox, Anamorph or PanScan

Right click mouse on your Channel (Image 3) and select:
- Add External device – to add GPI or Kramer Controls
- Add Live input – to add capture cards
- Add Output – to add Network or Card output
Network output properties

- Output name – network output name (optional)
- Encoder settings – here you can configure encoder (mpeg2 or h264) setting:

Using this interface, you can select codec and its parameters (Level, Profile, Bitrate). Higher bit rate provides better quality of the picture. Image resize option allows altering resolution of IP stream (in pixels). If this option is disabled, then outgoing stream will have the default resolution, defined during SD/HD channel configuration.
- Network interface – your network card interface
- Destination ip – destination ip address where your transport stream is going to (receiver)
- Port – port
- PID Video – video packet identifier
- PID Audio – audio packet identifier
- PID PCR – program clock reference

Do not forget to apply and save all your settings.

Key Info

In this window you can find information about your USB dongle. There are key ID number, number of days before expiration (if you have a trial) and how many channels you have bought.
VPlay Assets Manager

This module allows creating assets for the forward scheduling. Media library can be categorized, i.e. news, movies, commercials, etc. Descriptions could be added to the files. Blocks, consisting from several files could be created; entry and exit points could be designated; play back duration of separate files and even blocks could be altered.

In order to enable VPlay Assets Manager, run VPlay Assets Manager:

1. Go to SQL Server tab (Image 1) and enter:

   ![Image 1]

   **Server name** – your SQL server name
   
   **Authentication** – Windows Authentication
   
   **User name** – blank
   
   **Password** – blank

   Press **Check Database connection**, **Apply**

2. Open List of channels menu and press **Add channel** (Image 2)
   - Select your new channel and press **OK**
Select **The working directory is the channel** (e.g. – C:\VPlay3\Channel1, Image 3), press **Apply** to save changes.

- **Create shell link** button will create shortcut on your desktop.

3. Open **Options** menu to select VPlay asset editor options:
   - Auto upload media clips to work folder
   - Remove assets with media clip
   - Show tooltips for block editor timeline

4. Press **Ok** and **Restart** application buttons.
There are several ways to add assets (clips) in Asset Editor (Media Library)

First

- Press Add button (Image 4). In Create new asset window type your clip name, description, choose category and press OK.

Select File source destination (Image 5), press Apply (Image 6) and Upload media file button (Image 7)
Second

- Drag and Drop your clip in assets field (*Image 8 No 1*)

*Image 8*

Third

- Paste your clips in Channel Media folder and press Auto Make Assets button (Auto make assets).
In asset editor, you can create and assign different categories to your clips.

Press Category editor button to enter category editor window:

Press Add button to create new category.

You can write category name, description and assign particular color label.

When you select your clip, you can change some of asset properties in the right panel:

**Common options**
- Name – selected asset name
- Description – selected asset description
- Category – selected asset category

**Timecode**
- Timecode In – change timecode in of your clip manually
- Timecode Out – change timecode out of your clip manually
- Duration – change duration of your clip

**Asset media file**
- File source – select a path to the clip

Here you can also check Media Info for selected clip.
You can change timecode in and out for selected clip using preview window (Image 9).

![Image 9](Image 9)

Just press Timecode In or Timecode Out buttons (Image 9 №1 or №2) to trim your clip or press Move Start or Move End buttons (Image 9 №3 or №4) to get back to default clip timecode positions.

**Block assets editor**

Block assets editor is responsible for creating and managing blocks of clips. To create block press Add button (Image 10 №1), write block Name, Description and select Category. Then select your block (Image 10 №2) drag and drop clips (Image 10 №3) which you want to add to this block on a block timeline (Image 10 №4).
VPlay Channel Manager

This module is dedicated for scheduling and monitoring of broadcast. It has two modes – play back and editing. It supports Drag and Drop of files for easy scheduling and allows creating schedules for unlimited future dates. Interface allows controlling of logotypes, scenes, secondary events, adding of Live input, controlling GPI and matrix switchers.

In order to enable VPlay Channel Manager, run VPlay Channel Manager:

1. Go to SQL Server tab (Image 1) and enter:

   Server name – your SQL server name

   Authentication – Windows Authentication

   User name – blank

   Password – blank

   Press Check Database connection, Apply

2. Open List of channels menu and press Add channel (Image 2)
   - Select your new channel and press OK
Select the working directory is the channel (e.g. – C:\VPlay3\Channel1, Image 3), press Apply to save changes

Create shell link button will create shortcut on your desktop

3. Open Schedule menu to select Schedule editor setting:
   - You can show or hide some columns in schedule list
   - Choose intersection time between previous current and next day (ranges from 1 to 12 hours)

4. Press Ok and Restart application buttons.
Schedule editor mode

In VPlay Channel manager press button (Image 4, № 1) to enter schedule editing mode.

To add blocks in Block menu press Search button, select All Block Assets, press Search Now, OK.

Now you can drop your assets in your schedule to form day schedule. Do not forget to press Apply button (Image 5) after editing.

HINTS

In order to move your asset that has already been placed in schedule, select asset, hold Shift button on a keyboard and left mouse button, and now you can drag this asset and change asset position.

In order to copy your asset that has already been placed in schedule select asset, hold Ctrl button on a keyboard and left mouse button, and now you can drag this asset and copy it to different position.
Empty block, Live event, GPI command and MTX control

By pressing insert button, you can add in your schedule:

- Empty block – insert empty block into your schedule (you can configure empty block in VPlay Configurator)
- Live – insert live source into your schedule. You need to select live source from drop down list and set live event duration (HH:MM:SS:FR)

- External control – insert GPI command to your schedule. You need to select GPI external control from drop down list and assign input number.

By pressing Add MTX or Scene button you can add in your schedule:

- Scene (you can read more about creating scenes on page 27)
- Matrix control – insert matrix command to your schedule. You need to select Kramer control from drop down list and assign switch command (input and output)
VPlay Channel Manager interface in playback mode.

1. Play by current server time
2. Play by selected time you can select the exact time to start your playout from
3. Play from selected position
4. Skip current clip
5. Jump to selected clip
6. Stop playout
7. Bypass (available for SteamLabs cards only) — switch composite or SDI signals in card directly from Input to Output
8. Playout volume controls
9. No logo – disable all attached logotypes
10. Schedule logo – enable schedule logo mode
11. Assign logos – opens Assign logos window

HINTS

To position screen on currently playing clip in your schedule double click on current play list time (Image 1 №12).
VPlay Control Panel

This is a server module, which provides preview of video output along with overlaying graphics; monitoring of audio; reviewing of detailed information about the channel and monitoring of incoming live signal. In addition, it allows stop/restart a server and stop/restart each channel (in case of multichannel broadcast).

To start your VPlay server, go to VPlay Service Control and press Start button (Image 1).

![Image 1]

To preview your output video go to Preview, in drop down Select AV source menu select your output channel and press Start button (Image 2).

![Image 2]
VPlay Scene Editor

This module allows creating static and animated logotypes, scenes, digital and analog clocks, static and dynamic text.

In order to enable VPlay Scene Editor, run VPlay Scene Editor, go to Tools & Settings -> Settings

Select:

Server name – your SQL server name
Authentication – Windows Authentication
User name – blank
Password – blank
Press Ok.

To create logotype or scene go to File -> New

1. To create logotype go to File -> New -> Logo, select video standard and format for your output channel and press Ok button.

Now you can add static image by pressing - Add image or you can add animation by pressing - Add animation

VPlay Scene Editor supports only its own animation file format *.VPA. In order to create files with this extension you need to use the built-in utility for conversion «Image sequence converter».

- To create static logotype press Add image, select image file on your hard drive and left click on a screen, where you want this image to be located. You can change this image size and position using mouse or change it manually by typing Position (x, y) and Size (width, height) in object properties window.
Object properties window

Logo properties/Scene properties:

Name – here you can write your logo or scene name

Video Format – here you can see your logo or scene selected video standard and format

Duration – duration of the event

Enable change duration – enable or disable altering duration of a scene from the editor schedule

Show safe area – enable or disable safe area marker

Safe area – specifies offset of safe area marker in percentage points

Image object properties

Base properties:

Name – selected object name

Image file – image file destination

Keep aspect – enable or disable aspect ratio for selected object

Position (X, Y) – here you can manually change position of selected object

Size (W, H) – here you can manually change width and height of selected object

Duration – here you assign duration of selected object

Show delay – here you assign delay for showing of selected object

Effect in – enables special effect (Cut, Fade, Left, etc.) for selected object

Effect in duration – specifies duration of enabled special effect for selected object

Effect out – disables special effect (Cut, Fade, Left, etc.) for selected object

Effect out duration – specifies duration of disabled special effect for selected object

Object mask:

Mask enabled – enable or disable mask for selected object

Mask file – mask file destination
To create animated logotype press **Add animation**, select *.vpa* file on your hard drive and left click on a screen, where you want this animation to be located. You can change image size and position using mouse or change it manually by typing Position \((x, y)\) and Size \((width, height)\) in object properties window.

To create *.vpa* file you need to use Image sequence converter. Go to Tools & Settings -> Image Sequence converter.

1. Select your output channel video standard
2. Select source you can choose tga sequence or video file from
   If you choose video file, you can select what part of video clip you want to trim to create *.vpa* animation.

3. Select destination folder for your *.vpa* file
4. Press start button to create *.vpa* animation file

**Important:**

You have to save logotypes directly in your Channel Logos folder \(e.g. \ C:\VPlay3\Channel1\Logos\).
Static text object properties

Text style
Style – select predefined style (you can create additional styles in VPlay Text Style Editor)
Description – predefined style description
Save text style – save current text style in database, assign style name and description

Edit text
Edit text – edit currently selected text

Text Format
Font – current text font
Font size – current text font size
Bold – makes font bold
Italic – makes font italic
Underline – underlines current text
Wrap – wraps up current text
Text align – aligns current text left, right, center
Paragraph align – aligns current paragraph Near, Far, Center

Text color, outline, shadow
Color
Text Color – current text color
Alpha – specifies current text transparency
Outline
Enable Outline – enables or disables text outline
Outline Color – outlines color
Outline Alpha – specifies outline transparency
Outline Size – specifies outline size
Shadow
Enable shadow – enables or disables shadow
Shadow Color – shadow color
Shadow Alpha – specifies shadow transparency
Angle – specifies angle of deviation shadow
Offset – specifies shadow distance

Scroll text object properties

Edit text
Static text – enables or disables static text
Data source – select data source for scroll object
Data source description – scroll description of object data source
Edit text – disabled when static text is false

Scroll
Speed – specifies text scroll speed
Approximate Duration – approximate duration of scroll text
Direction – specifies scroll direction left or right
You can create two types of text scroll:

1. Press **Add scroll text** and left click on a screen, where you want this scroll text to be located. In object properties window in **Edit text** row select **Static text – True**
   This will be standard scroll text with one style that will scroll only once.

2. Press **Add scroll text** and left click on a screen, where you want this scroll text to be located. In object properties window in **Edit text** row select:
   - Static text – False
   - Data source – Scroll text data source

How to create ticker you can read on page 37 – 42.

- To create digital clock press **Add digital clock** and left click on a screen, where you want to place this clock. In object properties window you can adjust font, font color, style, etc.
- To create analog clock press **Add analog clock**. Add analog clock window will appear:
  - Background – select clock background image
  - Hour – select hour hand
  - Minute – select minute hand
  - Second – select second hand

Press **OK** button and left click on a screen, where you want clock to be located.

**Important:**
You need to save scenes directly in your Channel Scenes folder (**e.g. C:\VPlay3\Channel1\Scenes**).
Attaching Logotypes and Scenes to clips in VPlay Channel Manager

**Attaching Logotype**

1. Open VPlay Channel Manager, go to *Logo control* panel (Image 1 №1) and press *Assign logos* button (Image 1 №2). *Assign logos* window will appear (Image 1 №3).
2. Click Slot 1-16 and assign logotype to selected slot (Image 1 №4).

---

3.1 You can assign specific logotype for particular clips in your schedule:

- Enter Schedule editor mode
- Select clip or clips you want to assign your logotype to, then press *Select logo slot* button (Image 2 №1) and select logotype
- Press *Apply* button to save changes
- Leave Schedule editor mode and in *Logo control* panel press *Schedule logo* button

---

*Image 1*

*Image 2*
3.2 You can assign one selected logo for all clips in your schedule:

- In Logo control panel select desired logotype (Image 3 №1) to enable Manual logo mode (Image 3 №2)

![Image 3](image3.png)

**Attaching scenes**

1. Open VPlay Channel Manager and enter Schedule editing mode.
2. Select clip you want to assign your scene to, then press **Add MTX or Scene** button, choose **Add Scene** (Image 4 №1) and select scene you want to add.

![Image 4](image4.png)

If you want, you can assign several scenes to one clip. To edit scene offset time, duration and static text content, press **Edit** button.
VPlay Text Style Editor

This module allows creating text styles.

In order to enable VPlay Text Style Editor, run VPlay Text Style Editor, go to SQL Server tab and enter:

Server name – your SQL server name
Authentication – Windows Authentication
User name – blank
Password – blank

Press Check Database connection button, then Ok and Restart application buttons.

To create style press Add style button (Image 1).

Write your style name in Name field and style description in Description field.
Now you can select your style and change text style properties.

**Text Style**
- Font – current font
- Font size – current font size
- Bold – makes font bold
- Italic - makes font italic
- Underline – underlines current text

**Text color**
- Enable fill color – enable or disable text fill color
- Text Color – current text color
- Alpha – specifies current text transparency

**Text background color**
- Enable fill background – enables or disables text background color
- Background – current text background color
- Alpha – specifies current text background transparency

**Text outline**
- Enable – enables or disables current text outline
- Color – current text outline color
- Alpha – current text outline transparency
- Size – outline size

**Text shadow**
- Enable – enables or disables current text shadow
- Color – current text shadow color
- Alpha – current text shadow transparency
- Angle (Degree) – shadow angle
- Offset – shadow offset

Do not forget to press **Apply** button.
VPlay Content Template Editor

This module allows creating content holder templates.

In order to enable VPlay Content Template Editor, run VPlay Content Template Editor, go to SQL Server tab and enter:

Server name – your SQL server name

Authentication – Windows Authentication

User name – blank

Password – blank

Press Check Database connection button, then Ok and Restart application buttons.

To create content holder template press Add template button.

Write your template name in Name field, template description in Description field.
Select Show mode from the drop down menu:

**Continue show** – scroll one text after another

**Page break show** – second scroll text will appear only when the first one disappears

Now you can select a template and change content holder template properties.

By pressing **Add field** button, you can add more text style fields to your current template.

**Style** – here you select text style for your field

**Offset left** – here you can assign prefix offset values

**Offset right** – here you can assign postfix offset values
VPlay Text Content

This module is responsible for composing of dynamic text, here you fill your ticker content.

In order to enable VPlay Content Template Editor, run VPlay Content Template Editor, go to SQL Server tab and enter:

- **Server name** – your SQL server name
- **Authentication** – Windows Authentication
- **User name** – blank
- **Password** – blank

Press Check Database connection button, then **Ok** and **Restart** application button.

To add text object tab press **Tabs (Image1 №1)** button. Choose your text object and Switch **Use Tab** to On.

You can create text object in VPlay Scene Editor, just go to Tools & Settings -> Text content press Add button and write text object name and description. Press Ok button.
To create a ticker press Add button (Image1 №2). Now you can assign to your ticker a template you have created in VPlay Text Content.

**Text item properties**

- **Date-Time Begin** – set ticker begin time
- **Date-Time End** – set ticker end time
- **Date-Time period** – switch on and off date-time mode
- **Number of repeat** – set the amount of repeat runs (0 - 10000)
- **Priority** – set ticker priority (1-10, 0 – undefined)

**Text template**

- **Field 1** – here you enter content to your ticker (Image 2)

The number of fields depends on your content template.
VPlay Report

This module creates AS-RUN log and contains play back history – what video had been broadcasted, timestamp, duration, etc.

In order to enable VPlay Report, run VPlay Report, go to SQL Server tab and enter:

![Image of VPlay Report Settings]

- **Server name** – your SQL server name
- **Authentication** – Windows Authentication
- **User name** – blank
- **Password** – blank

Press Check Database connection button, then **Ok** and **Restart** application button.

![Image 1]

To view the report select your channel from drop down menu (Image 1 №1), select filter criteria (Image 1 №2) and press **Query** button (Image 1 №3) to generate a report.

You can assign additional search criteria using search panel (Image 1 №4): Search report for all assets; Search by asset name; Assign asset time interval.
**VPlay Monitor**

VPlay Monitor is intended for playout control of one or several channels by system operator or any other member of staff.

It provides both – visual control by «preview» window and sound indicators, and instrumental control through TV channels service information, progress-bars, schedules, system logs, etc. The operator tracks out all changes in a schedule made by media-planners of the channel, what significantly declines possibility for human errors.

In order to enable VPlay Report, run VPlay Report, go to **SQL Server** tab and enter:

![VPlay Monitor Settings](image)

- **Server name** – your SQL server name
- **Authentication** – SQL Server Authentication
- **User name** – your SQL Server user name (e.g. sa)
- **Password** – your SQL Server password

Press Check Database connection button and go to **Channel configuration**.

![Channel Configuration](image)

In **Channel Configuration** press **Add** button, select Type 0 if you want to monitor one channel (if you want to monitor more channels, just select desirable amount of channels from drop down menu) and press **Ok** button.
Now select your Configuration from Configuration list and select a channel for monitoring from Server GUID ID. Press Ok and Restart application button.

Now you can monitor your Channel.
Internet streaming

Using VPlay3 software you can organize broadcasting to World Wide Web.

Mostly broadcasters use Adobe Media Server, Windows Media Server or Wowza Streaming Engine.

The general schema of broadcast to Internet consists of following steps:

1. Forming play-out in VPlay3.
2. Encoding outgoing video signal from Vplay3. For this purpose, you may use either free software Microsoft Expression Encoder or Adobe Flash Media Encoder.
3. Organizing internet broadcast. For Microsoft Expression you have to use Windows Media Server; for Adobe Flash Media Encoder you have to use Adobe Flash Server (these servers are paid products and not included in our package). These servers distribute streams to internet users.

Conclusion. Step one and step two can be completed using our software (VPlay3) and free encoding software Microsoft Expression Encoder or Adobe Flash Media Encoder.

Step three is yours responsibility. **We do not provide support for media server configuration!!!**

If you want to setup broadcast to the internet, you have to resolve step three first.

There are also another solutions for streaming stream to the internet: XSplit software and Wowza Streaming Engine.

XSplit is a partially free live streaming software. You can create live stream to a wide variety of recipients. XSplit Broadcaster works with all popular live stream providers – Justin.tv, Livestream, Twitch, UStream, Youtube.

Wowza Streaming Engine is unified streaming media server software. Wowza Streaming Engine can provide streaming to various types of playback clients and devices simultaneously, including Adobe Flash player (Adobe RTMP, Adobe HDS), Microsoft Silverlight player, Apple QuickTime Player and iOS devices (iPad, iPhone, iPod Touch), 3GPP mobile phones (Android, BlackBerry OS, Symbian, etc.), IPTV set-top boxes (Amino, Enseo, Roku, Streamit and others), and game consoles such as Wii, Xbox, and PS3.
Adobe Flash Media Live Encoder 3.2

Adobe Flash Media Live Encoder (FMLE) – is a media encoder that captures and streams audio and video in real time to Adobe Media Server (AMS) software or Flash Video Streaming Service (FVSS).

FMLE is a desktop application that connects to AMS or FVSS via Real Time Messaging Protocol (RTMP) to stream live video to connected clients. Clients connect to the AMS or FVSS server and view a stream through a Flash Player.

VPlay server includes virtual driver for compatibility with Adobe Flash Media Live Encoder, which allows broadcasting in RTMP.

Setting up Adobe Flash Media Live Encoder

Run Adobe Flash Media Live Encoder 3.2. In drop down menu select:

Video – Device: VPlayCapture

Audio – Device: VplayCapture

Depending on your computer specs and connection speed, you should adjust the encoding settings to provide best quality and press Start button.

Video Settings

Device

This is your video capture device source. You need to select VPlayCapture here.
Format
You can select H.264 or VP6 encoder.

Frame Rate
This must match the frame rate of the device (VPlayCapture).

Input Size
This is capture video size.

*Maintain Aspect Ratio* This should be checked - it will ensure that the output ratio stays the same as the input ratio to ensure that an image is not shrunk or stretched.

Bit Rate
This should be set based on your level of available upstream bandwidth as well as the expected downstream connection speed of your audience.

Output Size
This should match the size of the embedded player you are encoding for and should be the same size or smaller than the input size.

Crop
By cropping you can remove any black bars surrounding a picture.

Audio Settings

Device
This is your audio capture device source. You have to select VPlayCapture here.

Format
This is your audio formats mp3, AAC, HE-AAC

Channel
This specifies the channel option, mono or stereo.

Sample Rate
This specifies the audio sample rate in Hz.

Bit Rate
This specifies the audio encoding bit rate, for higher quality broadcast recommended parameters are 96Kbps or 128Kbps, for lower quality broadcast recommended parameters are 48Kbps or 64Kbps.

Streaming settings

Stream to Flash Media Server
Here you have to enter your FMS url, backup URL and stream.
Microsoft Expression Encoder 4

Microsoft Express Encoder is an advanced audio and video-encoding and live-broadcasting application that captures and streams in real time to Windows Media Server. It can create video streams for distribution via Microsoft Silverlight.

Setting up Microsoft Express encoder

Open express encoder and select Live Broadcasting project.

Go to File -> Add Live Source

In Video Device drop down menu select VPlayCapture.

In Audio Device drop down menu select VPlayCapture.

Select an output tab on the right hand panel.

When an encoder is providing a stream for a broadcast, it can either push the stream to the server or the server can pull it from the encoder. When pushing a stream, the encoder initiates the connection to the server; on the other hand, when pulling the stream from the encoder, the server initiates the connection.

For **Push** distribution

- Mark the Publishing Point check box
- Enter details for your streaming account in the Location field
- Click **Connect** button to test the connection
- A separate window should now appear, requesting your username and password. Enter the username and password for your stream

For **Pull** distribution

- Mark the Broadcast check box
- Choose a port number for the broadcast
- Choose a maximum number of connections
- Click the **Test** button

Click **Start** in the central panel to start broadcasting on your Windows Media Streaming account.

See Microsoft documentation for more details.
XSplit Broadcaster

XSplit is a partially free live streaming software. You can create live stream to a wide variety of recipients. XSplit Broadcaster works with all popular live stream providers – Justin.tv, Livestream, Twitch, UStream, Youtube. You can use XSplit software to broadcast your VPlay playout.

Setting up XSplit Broadcaster

Just run XSplit and select VPlayCapture as Scene Source. Assign desirable settings, select streaming service and star broadcasting.

See XSplit Broadcaster documentation for more details.
Wowza Streaming Engine

Wowza Streaming Engine is unified streaming media server software. Wowza Streaming Engine can stream to various types of playback clients and devices simultaneously.

You can capture VPlay3 UDP MPEG-TS using Wowza, convert it to MPEG-DASH, Apple HLS, Adobe RTMP, Adobe HDS, Microsoft Smooth Streaming or RTSP/RTP and broadcast to the internet.

You can read more about capturing UDP streams using Wowza here: